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Blackbaud NetCommunity Spark provides your organisation with a website program for users of all
levels. You can create web pages with multiple layers of layout, template, and page design. You can
generate and send an email to individuals and groups; define user roles and set security for each
section; and track statistics about website usage. Website users can also make donations or register for
events with online forms you create.
In addition, the program can integrate your website and your other Blackbaud products. Website users
enter data into areas of your website such as profiles and donation forms, and you can download that
data to another Blackbaud program. This documentation is for the administrative side of the program,
which consists of Site explorer, Email, Users & security, and Administration. Together, these sections
contain all the tools you need to create your organisation’s website.
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Show Me: Watch an overview about basic navigation and features in Blackbaud NetCommunity Spark.

Note: To access the user guides, visit www.blackbaud.co.uk.

Users
Depending on your role, you will perform different tasks to fulfill your website needs. For example, if
you are the Site Administrator, your job in the program is most likely to create web pages from start to
finish and assign roles to users. If you are the Director of Special Events, your job may be to update last
year’s Golf Tournament web page with this year’s golf tournament information. If you are the Data
Entry Manager, your job is to download information from the website and integrate the information
with The Raiser's Edge. Lastly, your constituents use the program directly from your website.

Warning: Your organisation should assign full Administrator rights to only a select number of users.
These users should be knowledgeable in all areas of website design and the program. Certain areas,
such as Site explorer, are crucial for your website. A small change can affect multiple web pages. This
functionality saves your organisation a lot of time and effort. However, if a change is incorrect, you
have to spend time and effort to correct the change. We strongly encourage you to establish security
that limits general users’ access to these areas.
Constituents perform tasks such as registering for events, joining memberships, and making donations.
After a constituent submits these tasks, you can download the information to The Raiser's Edge. This
section outlines possible main user roles and provides a roadmap for the main tasks each role
performs in the program.

UserTasks
A wide range of users perform tasks in the program. Many tasks are captured in the user roles of an
administrator, a website designer, a user from The Raiser's Edge who also uses the program (most
likely someone in the Development office), and a constituent.
Review the following user task examples to become familiar with the tasks you can perform,
depending on your user role:

Administrator
l Research audience/design needs
l Establish Blackbaud NetCommunity security

o Define roles, create users
l Site setup

o Set up login page, system options, and credit card

Site Designer
l Create stylesheet
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l Create page layouts/templates/stylesheets/images
l Design pages and create content parts

Raiser's Edge User
l Define attributes
l Create queries in RE for roles
l Download transactions to RE
l Usage reporting
l Create email lists; send email

Constituent
l Event Registrations/Membership/Transactions/Donations
l Post jobs
l Post discussion topics
l Create profile

For information about security, see the Users & Security Guide.
For information about Site explorer,see the Website Design Guide. For information about Parts and Web
Traffic Reports, see the Parts Guide.

IntegrationTasks
Some individuals (most likely in development) at your organisation may have responsibilities that are
common to both the program and The Raiser's Edge. For example, your events data entry person may
also be responsible for updating the events page on your website.
If the roles for your job are similar to this, review the following diagram for an example of integration
between the program and The Raiser’s Edge. If you have rights to create and edit parts or pages of
your website, this diagram helps you get started in the program and understand how the integration
process works.
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For information about online and offline tasks a user can perform, see the Website Design Guide, the
Parts Guide, the Email Guide, and The Raiser's Edge user guides.

Data EntryUser
If you are responsible for The Raiser’s Edge data entry, you should periodically download information
entered through your website. The following diagram explains where data downloads to The Raiser’s
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Edge. The diagram does not include all transaction types.

For details about the tasks a Raiser’s Edge data entry user performs, see the Blackbaud NetCommunity
Spark & The Raiser’s Edge Integration Guide and your Raiser’s Edge user guides.
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Navigate
The program contains the commands necessary to complete all website functions. Learning to
navigate is the first step to use the program to its fullest potential.

Show Me: Watch an overview of basic navigation and features in Blackbaud NetCommunity Spark.

MenuBar
Throughout the program, the menu bar appears at the top of the screen. For users with administrative
rights, the menu bar also appears on your website. Use the menu bar to access the different sections of
the program and perform various tasks.

View your live website
1. Select View site or View this page.
2. To return to the program, click Edit this page or select an option in the menu bar.
3. You can toggle between the program and your website to view changes as you make them.

Create website pages
• To create a page, part, template, or style sheet, select an option under Create.

Access recently edited items
1. To return to a recently viewed part, page, template, style sheet, or email design, click History.
2. Access the past 10 parts, pages, templates, and style sheets, and the past 20 email designs that

you edited.
3. The items that appear are based on your user login.

Create/edit website content
• To create and edit content for your website, select an option under Site explorer. You use these
options to design your website.

• Layouts give your website a consistent look and feel, and then you create pages and templates
based on the layouts.

• Parts place content on your website, and you use style sheets to control content appearance. You
can also upload and store images, create friendly URLs for web pages, and manage the approval
process for Formatted Text and Images parts.

For more information about Site explorer, see the Website Design Guide.
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Manage email messages
• To manage email lists and design email messages, select an option under Email. You use these
options to manage email communications with website users and view reports.

• You create templates for email messages and lists of email recipients, and then you create the
messages, newsletters, acknowledgements, and notifications to send.

• You can also create email campaigns, view email addresses that are reported as “invalid,” and
create templates for eCards.

For more information about Email, see the Email Guide.

Manage users and site security
• To manage security for your website:
1. Select an option under Users & security.
2. You use these options to:

l Manage user accounts
l Create user and task groups
l Add security assignments to apply security throughout your website
l Import data from other Blackbaud programs to create website users

For more information about Users & security, see the Users & Security Guide.

Configure system properties
• To configure system properties and other administrative settings:
1. Select an option under Administration.

l You use these options to select whether to host a single website or multiple sites for your
organisation and to configure global and site-specific settings.

l You can also configure merchant accounts to accept payments, set privacy settings for
profile fields, and create code tables for event categories.

For more information about Administration, see the Administration Guide.

Access site help
• For information about the program, select an option under Help. You can access the help file, view
PDF versions of the help files, watch a tutorial about how to navigate the program, contact support,
and view specific information about your version of the program.

Edit a different website
• If you host multiple sites, the current site appears on the bottom left of the menu bar.
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• To manage a different site:
1. Click change.
2. Select the site from the dropdown list.

Sites only appear if you have rights to access them.
• Your username appears in the bottom right of the menu bar. To log out, click Logout.

ActionBar
The action bar contains buttons for you to use on a specific screen. Several of these buttons remain on
most screens, for example, Delete. However, some buttons on the action bar are specific to a particular
screen, for example, Copy template on an existing Templates screen.

Internet BrowserButtons
To navigate back and forth between screens in the program, use the Back and Forward arrow buttons
on your Internet browser toolbar. All other buttons in browser control Internet settings.

CommonProcedures
Throughout the program, you can perform similar tasks from different parts. For example, you use a
powerful HTML editor to format and layout several features, such as email, newsletters, and content on
web pages. You can use a search screen from different parts to help find and select data to use, such as
a constituent query to use to create a Directory part or an appeal for a Donation form.

HTMLEditor
The program provides a powerful HTML editor to allow you to format and lay out content. With the
HTML editor, you can update content easily and safely while you maintain control over the design and
content.
Before you create content in the HTML editor, you should design custom stylesheets to create unique
elements such as colours, spacing, and font types and sizes for your website. For more information
about stylesheets, see the Website Design Guide.
You can use the HTML editor in different views, depending on your HTML experience and where you
access the HTML editor in the program.

Warning: When you create and design emails in the program, use inline styles, such as <div
style=”background-color:Blue;”>Welcome colour</div>. Do not define classes or use
external references because email vendors, such as Gmail or Outlook, are not guaranteed to render
the styles correctly when the recipient reads the email.
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• Normal – When you open the HTML editor to create or edit content, this is the “normal” view. This
view is similar to a standard word processing application. By default in normal view, when you
press ENTER, you create a <p> tag in the HTML content to indicate a new paragraph. When you
press SHIFT + ENTER, you create a <br> tag to indicate a single carriage return in the content.

Tip: Your system administrator can adjust this configuration in Administration.
• HTML – To view or edit the HTML source code, click HTML Code on the View tab in the toolbar.
The HTML Source Editor screen appears. To return to the normal view, close the window. You
cannot use the HTML view to embed your own form via HTML in the HTML editor.

• Preview – To view the content as it will appear on the web page and to test hyperlinks, click
Preview on the View tab in the toolbar. The Preview screen appears. To return to the normal view,
close the window.

HTMLEditor Functions
These tables explain the buttons and menus on the toolbar of the HTML editor. Some features have
more buttons available than others.

Note: On your website, users can use an HTML editor with a limited set of these buttons on some
parts. With the HTML editor, users can also insert images, tables, or links.

Buttons andMenuson theToolbar
Show Me: Watch how to use the HTML editor ribbon toolbar.
Formatting Tab

Button Function Description
Cut To remove text from the content area and copy it to the clipboard, click Cut.

The text is removed, and you can paste it elsewhere in the content area.

Copy To copy text to the clipboard, click Copy. You can paste the text elsewhere in
the content area.

Paste To paste text from the clipboard to the content area, click Paste.

Font family
menu

This menu lists common fonts that appear on most web browsers. To change
the font applied to text, select a font.

Font size
menu

To change the size of text, select a size from this menu.

PROGRAM BASICS 12
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Button Function Description
Insert
unordered
list

To insert a bulleted list, click Insert unordered list. The HTML editor adds an
<ul> tag at the selected location. The items in the list have bullets. To end a
list, click Insert unordered list again.

Insert
numbered
list

To insert a numbered list, click Insert numbered list. The HTML editor adds
an <ol> tag at the selected location. The items are numbered sequentially,
starting with “1.” To end a list, click Insert numbered list again.

Indent text To increase an indent, click Indent text. The HTML editor adds a
<blockquote> tag around the paragraph. If you increase the indent for a list
item, the number or bullet changes to indicate a secondary relationship to
the list.

Outdent text To decrease an indent, click Outdent text. The HTML editor removes the
<blockquote> tag around the paragraph. If you decrease the indent of a list
item, the text becomes plain text. If you decrease the indent of a secondary
list item, the number or bullet becomes part of the parent list.

Help To access a description of the HTML editor features, click Help. The help file
appears.

Bold To make text bold, click Bold. The HTML editor adds a <strong> tag around
the text.

Italic To italicise text, click Italic. The HTML editor adds an <em> tag around the
text.

Underline To underline text, click Underline. The HTML editor adds a <u> tag around
the text.

Strikethrough
text

To strike a line through text, click Strikethrough text. The HTML editor adds
a <strike> tag around the text.

Text colour To change the colour of text, click Text colour and select a colour from the
palette. The HTML editor adds a <span> tag with the colour around the text.

Highlight To highlight text, click Highlight and select a colour for the highlight from
the palette. The HTML editor adds a <span> tag with the background colour
around the text.

Align left To align text to the left, click Align left. The HTML editor adds an attribute of
align=left to the division.

Align center To align text to the center, click Align center. The HTML editor adds an
attribute of align=center to the division.

Align right To align text to the right, click Align right. The HTML editor adds an attribute
of align=right to the division.
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Button Function Description
Align full To fully justify text, click Align full. The HTML editor adds an attribute of

align=justify to the division.

Superscript To display text above the rest of the text around it and make it slightly
smaller, click Superscript.

Subscript To display text below the rest of the text around it and make it slightly
smaller, click Subscript.

Spell check To check the spelling, click Spell check. When you turn the spell checker on,
it checks the spelling of all existing content in the HTML editor and will check
new content as you create it. When the spell checker finds an error, a red
squiggly line appears below the word. Right-click the underlined word to
select the correct spelling. You can also spell check in different languages.
Use the drop-down to the select the language.

Find and
replace

To find and replace text, click Find. The Find/Replace screen appears. In the
Find what field, enter the text to search for. In the Replace with field, enter
replacement text. To search for the text, click Find next. To replace the text,
click Replace. To replace all instances, click Replace all.

Format menu To apply a paragraph or header tag to text, select a format from this menu.
For example, select “Standard” for body text.

Remove
formatting

To remove formatting from text, click Remove formatting. The HTML editor
removes any special format attributes, and the text appears as plain text.

Undo To undo the last action in the content area, click Undo. The action is
reversed. You can undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is
reinstated. You can redo multiple actions.

Insert Tab

Button Function Description
Insert/edit
table

To create a table, click Table.The Insert/Edit Table Screen appears. For more
information about the options on this screen, see Insert/Edit Table Screen on
page 22.

Insert
image

To insert an image, click Image. On the Select Image from Image library screen,
you can select the image.

Insert link To link text to a web address or web page, click Link. If the text is in a format
that the program recognises as a web address or page, such as
www.abc123.org, the link formats automatically. Otherwise, the page link
screen appears.
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Button Function Description
Remove
link

To remove a hyperlink from text, click Remove link. The text no longer acts as a
hyperlink.

Insert/edit
anchor

To link to a specific location on a page, place your cursor at the link’s endpoint
(for example, a heading) and click Anchor. The Insert/edit anchor screen
appears so you can enter a name for the anchor’s location. The HTML editor
adds <a name="anchor name"></a> before the defined location. In the normal
view, the HTML editor displays an anchor symbol at the defined location.

To link to the anchored location, in the HTML source view, append
“#anchorname” to the end of the link.

Insert
special
characters

To insert a special character, click Special chars. The Select custom character
screen appears. In the grid, select a character. The custom character appears at
the selected location.

Insert
horizontal
ruler

To insert a horizontal line, click Horizontal ruler in the toolbar. The Insert
horizontal rule screen appears. Enter the width and height for the line and
select whether to include a shadow.

CSS class
menu

To change the Cascading Style Sheet (CSS) format, select a CSS class from this
menu. This menu displays only in the layout editor.

Insert
merge
fields

To add merge fields with personalised information to the HTML content, click
Merge fields. For more information, see Merge Fields on page 19. This button
does not appear in the layout editor.

Insert
conditional
content

To add conditional content to an email message to customise the message for
different types of recipients, click Conditional content. On the Conditional
Content screen, you can create the first conditional content block. You can
then define the content and select the group of recipients who view it.

This button appears only on the add/edit screens for email templates,
messages, newsletters, and eCampaigns.

For more information about how to add conditional content, see the Email
Guide.

If you send an email message fromBlackbaud Direct Marketing, this option
does not appear.

Insert
content
placeholder

On the add or edit layout screen, you can click Content placeholder to add
panes for parts to the layout. A yellow icon appears as a placeholder for a pane.
When you create templates and web pages, a pane contains multiple parts. You
select the parts to appear in the pane.

For more information about how to preview conditional content, see the
Website Design Guide. This button appears only in the layout editor.
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Button Function Description
Undo To undo the last action in the content area, click Undo. The action is reversed.

You can undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is
reinstated. You can redo multiple actions.

View Tab

Button Function Description
Full screen To work in full screen mode, click Full screen. To turn off full screen mode and view the

screen at its normal size, click Full screen again.

Preview To view the content as it will appear on the web page, click Preview. The Preview screen
appears. To return to the normal view, close the window.

Edit HTML
code

To view or edit the HTML source code, click HTML Code. The HTML Source Editor
screen appears. To return to the normal view, close the window.

Conditional
content
preview

To verify that conditional content appears as expected for each group of recipients,
click Conditional content preview. The View Message screen appears.

This button appears only on the add/edit screens for templates, messages, and
newsletters.

For more information about how to preview conditional content, see the Email Guide.

If you send an email message fromBlackbaud Direct Marketing, this option does not
appear.

Style sheet
options

To render content on a page, the program uses the style sheet associated with the
page’s layout. To view your content with style sheets applied and edit the content for a
specific style sheet, click Style sheet options.This button appears only on formatted
text and images parts. On the Style Sheet Options screen, you can select the style sheet
to view and override the background and foreground colours of the HTML editor to
improve readability. For more information about how to view content with style sheets
applied, see Style Sheet Options on page 20.

Undo To undo the last action in the content area, click Undo. The action is reversed. You can
undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is reinstated. You
can redo multiple actions.

Image Tab
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Button Function Description
Insert/edit
alternative
text

To add or edit the text that appears in place of the image if it cannot display, select it
and click Alt text .

Grow To make an image larger, select it and click Grow.

Shrink To make an image smaller, select it and click Shrink.

Edit image To edit an image, select it and click Edit image. The Insert/Edit Image screen appears.
You can make changes to the image properties and settings on the General,
Appearance, and Advanced tabs.

Remove
image

To remove an image, select it and click Remove image.

Undo To undo the last action in the content area, click Undo. The action is reversed. You can
undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is reinstated. You
can redo multiple actions.

Table Tab

Button Function Description
Delete
table

To delete a table, select it and click Delete table.

Row
properties

To edit the properties of a row, select it and click Row properties. The row properties
screen appears. For more information about row properties, see HTML Editor Table and
Line Properties on page 22.

Cell
properties

To edit the properties of a cell, select it and click Cell properties. The cell properties
screen appears. For more information about cell properties, see HTML Editor Table and
Line Properties on page 22.

Insert
column to
the left

To insert a column to the left of a column in a table, click Insert column to the left. A
new column appears.

Insert
column to
the right

To insert a column to the right of a column in a table, click Insert column to the right. A
new column appears.

Delete
column

To remove a column from a table, click Delete column. The column is deleted.

Insert row
above

To insert a row above a row in a table, click Insert row above. A new row appears.
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Button Function Description
Insert row
below

To insert a row below a row in a table, click Insert row below. A new row appears.

Delete
row

To remove a row from a table, click Delete row. The row is deleted.

Merge
table cells

To merge a cell with the cell to its right, clickMerge table cells. Any content in the cell
on the right is removed, and the selected cell now spans both columns.

Split
merged
table cells

To split a cell that spans multiple rows into two cells, click Split merged table cells. The
selected cell no longer spans the row on the bottom.

Show
table
borders

To hide or reveal the borders of your tables, click Show table borders.

Undo To undo the last action in the content area, click Undo. The action is reversed. You can
undo multiple actions.

Redo To redo an undone action in the content area, click Redo. The action is reinstated. You
can redo multiple actions.

Menuson theToolbar

Menu Menu name Description
Font menu This menu lists common fonts that appear correctly on most web

browsers. To change the font applied to text, select a font.
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Menu Menu name Description
Size menu To change the size of text, select a size from this menu.

Paragraph
menu

To apply a paragraph tag to text, select a format from this menu.
For example, select “Normal” for body text.

Merge Fields
To create personalised content, use merge fields to display offline information. For example, in an
email, you can insert the First name merge field so it displays “Hello, <First name>” to the recipient.
• To add merge fields, clickMerge fields on the Insert tab in the HTML editor toolbar. The merge
fields list appears in a separate window that you can move around.

• To view the available fields, click the plus sign next to a group of fields to expand the list.
• You can double-click or drag and drop merge fields from the window to the content area.
• You can add multiple fields at a time. To do this, place your cursor to the left or right of the group
name or fields (not over the group or fields) and click and drag your mouse to select them. After
the fields are selected, you can drag them as a group to the content area.
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Style SheetOptions
On your website, the program uses the style sheet associated with a web page’s layout to render the
content you enter in the HTML editor. Because the part on which you enter the HTML content may be
shared across multiple web pages with different style sheets, you may need to edit the content as
necessary to improve its readability with a specific style sheet. When you use the HTML editor in the
normal view, you can view the content as it appears with different style sheets applied.

Note: Other styles, such as those applied to the containers of the part, may affect how the content
appears on the web page. To see how the HTML content ultimately appears on a specific web page,
we recommend you use Pages & templates. For information about Pages & templates, see the Website
Design Guide.

View HTML content with a specific style sheet applied
1. On the View tab in the HTML editor toolbar for formatted text and images parts, click Style

sheet options. The Style sheet Options screen appears.
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2. In the Edit using style sheet field, select the style sheet to apply to the content in the HTML
editor.

3. Depending on the style sheet, the background and foreground colours of the HTML editor
may affect the readability of your text. Change the background and foreground colours of the
HTML editor as necessary to edit the content.
a. Select Override style sheet colours.
b. Select the colour to adjust. For the background colour, click Select next to Editor

background colour. For the foreground colour, click Select next to Editor default font
colour.
The Select a colour screen appears. Using the tabs, you can pick a colour three different ways
or enter its hexadecimal value in the Colour field.

c. Click Apply. You return to the Style sheet Options screen.
4. Click OK. You return to the HTML editor. The content appears with the selected style sheet and

colours applied.
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HTMLEditor Table and Line Properties
In the normal view, you can use the HTML editor to design tables, table rows, table cells, and
horizontal lines that divide the web page. You can also adjust the properties for these items to
determine characteristics such as size, styles, and colour.
• To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table
Screen appears. On the General and Advanced tabs, you can design the table and adjust its
properties. We recommend only users familiar with HTML and CSS style elements adjust the
properties on the Advanced tab. For more information, seeInsert/Edit Table Screen on page
22Insert/Edit Table Screen on page 22.

• To edit the properties of a row in a table, select the row and click Row properties on the Table tab
in the toolbar. The Table Row Properties screen appears. On the General and Advanced tabs, you
can design the row and adjust its properties. We recommend only users familiar with HTML and
CSS style elements adjust the properties on these tabs. For more information, see Table Row
Properties Screen on page 25.

• To edit the properties of a cell in a table, select the cell and click Cell properties on the Table tab
in the toolbar. The Table Cell Properties screen appears. On the General and Advanced tabs, you
can design the cell and adjust its properties. We recommend only users familiar with HTML and
CSS style elements adjust the properties on these tabs. For more information, see Table Cell
Properties Screen on page 28.

• To insert a horizontal line, click Horizontal ruler on the Insert tab in the toolbar. On the screen that
appears, enter the width and height for the line and select whether to include a shadow.

Insert/Edit Table Screen
To create a table, click Table on the Insert tab in the HTML editor toolbar. The Insert/Edit Table Screen
appears. On the General and Advanced tabs, you can design the table and adjust its properties. We
recommend only users familiar with HTML and CSS style elements adjust the properties on the
Advanced tab. After you create a table, you can select the table and click Table to edit its properties.
General Tab
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Screen Item Description
Cols Enter the number of columns.

Cellpadding Enter the amount of space to appear between the ruled line and the content of a cell in
the table.

Alignment Select the horizontal alignment of the table. You can select Left, Center, Right, or Not
Set.

Width Enter the pixel dimensions to use for the cells.

Class Select the CSS class to apply.

Table caption Select this checkbox to display a caption at the top of the table. To remove the table
caption, clear the checkbox or delete its code in HTMLmode.

Rows Enter the number of rows.
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Screen Item Description
Cellspacing Enter the amount of space to appear between cells of the table.

Border Enter the width, in pixels, of a border around the table. To display the table with no
border, enter “0.”

Height Enter the pixel dimensions to use for the cell.

Advanced Tab

Screen Item Description
ID Enter a unique identifier for the table.
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Screen Item Description
Summary Enter a summary of the table, such as for speech-synthesising or non-visual browsers.

Style Enter the CSS class to apply to the table.

Language code Enter the language code for text in the table, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the table or cell, click Browse to
open the Image library and select an image.

Frame Select this checkbox to display a caption at the top of the table To remove the table
caption, clear the checkbox or delete its code in HTMLmode.

Rules Select which ruled lines appear between cells of the table. You can select to display all
lines, no lines, or only those between rows, columns, or groups.

Language direction Select the directionality for text in the table — left to right or right to left.

Border colour Enter the colour for the border of the table. You can enter the standard colour name or
hexadecimal value, or click Browse to select the colour from the palette.

Background colour Enter the colour for the background of the table. You can enter the standard colour
name or hexadecimal value, or click Browse to select the colour from the palette.

TableRowProperties Screen
To change the properties of rows in the table, select a row and click Row properties on the Table tab
in the HTML editor toolbar. The Table Row Properties screen appears. We recommend only users
familiar with HTML and CSS style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which rows to update with changes — the current
row, odd rows in the table, even rows in the table, or all rows in the table.
General Tab
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Screen Item Description
Row type Select Header, Body, or Footer for the row type.

Alignment Select the horizontal alignment of the row. You can select Left, Center, Right, or
Not Set.

Vertical alignment Select the vertical alignment of the row. You can select Top, Center, Bottom, or Not
Set.

Class Select the CSS class to apply to the row.

Height Enter the pixel dimensions to use for the row height.

Advanced Tab
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Screen Item Description
ID Enter a unique identifier for the row.

Style Enter the CSS class to apply to the row.

Language direction Select the directionality for text in the row — left to right or right to left.

Language code Enter the language code for text in the row, such as “en-US” for United States English.
This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the row, click Browse to open
the Image library and select an image.

Background colour Enter the colour for the background of the row. You can enter the standard colour
name or hexadecimal value, or click Browse to select the colour from the palette.

27 CHAPTER 1



TableCell Properties Screen
To change the properties of cells in the table, select a cell and click Cell properties on the Table tab in
the HTML editor toolbar. The Table cell properties screen appears. We recommend only users familiar
with HTML and CSS style elements adjust the properties on the Advanced tab.
Use the field at the bottom of the screen to select which cells to update with changes — the current
cell, all cells in the row, all cells in the column, or all cells in the table.
General Tab

Screen Item Description
Alignment Select the horizontal alignment of the cells You can select Left, Center, Right, or Not

Set.

Vertical alignment Select the vertical alignment of the cells You can select Top, Center, or Bottom.

Width Enter the pixel dimensions to use for the cell width.
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Screen Item Description
Class Select the CSS class to apply to the cell.

Cell type Select whether the cell is a header for a column or includes data.

Scope Select whether the cell type applies to the column, row, group of columns, or group
of rows.

Height Enter the pixel dimensions to use for the cell height.

Advanced Tab

Screen Item Description
ID Enter a unique identifier for the cell.

Style Enter the CSS class to apply to the cell.

Language direction Select the directionality for text in the cell — left to right or right to left.
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Screen Item Description
Language code Enter the language code for text in the cell, such as “en-US” for United States English.

This allows the browser to render content more meaningfully based on accepted
cultural practice for the specified language, such as applying correct punctuation and
assisting screen readers and search engines.

Background image To insert an image that appears as the background of the cell, click Browse to open
the Image library and select an image.

Border colour Enter the colour for the border of the cell. You can enter the standard colour name or
hexadecimal value, or click Browse to select the colour from the palette.

Background colour Enter the colour for the background of the cell. You can enter the standard colour
name or hexadecimal value, or click Browse to select the colour from the palette.

SearchScreen
You may need to select data from the database to create parts for your website. For example, you can
select a constituent query to use to create a Directory part or an appeal for a Donation form on your
website. To help find and select data to use, the program provides a search screen specific to the type
data you need. On the Search screen, you can enter search criteria to help find the data. The criteria
options available depend on the type of data needed.

Note: If you are searching for a query, the Raiser’s Edge query types of constituent, gift, and job are
available in the program.

Use the search screen to select data
Search results that appear in the grid must match all the criteria you enter. We recommend you
search by one or two of the most helpful criteria types. If you enter too much criteria, you can
exclude the data you want.
1. On the search screen, enter the criteria to use to find the data. The criteria options available

depend on the type of data you need.
l To search the database for all data of that type, leave the criteria fields empty.

2. Click Search. The program searches the database for data that meet the criteria entered and
displays the results in the grid.

l If the search returns multiple pages of results, use the First, Previous, Next, and Last
buttons to navigate through the pages of results.

3. In the grid, find the data to use and click Select next to its listing. You return to the previous
screen.
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Insert Image
Insert images from the HTML editor and several parts, such as the Navigation Buttons part, Weblog
part, and User Photos Form part.
Use the Insert image button to select and insert an image from the Image Library.

1. Select the Insert image button on the HTML editor.
The Insert Image screen appears. From this screen, the user can insert an image and load or
edit existing images.

2. To configure the user’s Image library, including image approval, use the Settings tab in Sites &
settings.

Note: For information about the Image library, see the Website Design Guide.

Insert an image
1. To insert an image:
1. On the Edit Part screen, click the Insert image button.
2. The Select Image From Image library screen appears.
3. On the Folders tab, you can select a folder to view its images.
4. On the Search tab, you can search for images by name, tag, ID, image type, approval status, or

site. After you click Search, the images that meet your criteria appear in the grid.
5. In the grid, select an image and click Insert. You return to the previous screen.

CreatePage Link
From the HTML editor and several parts, such as the Formatted Text and Images and Menu parts, you
can create a hyperlink to a personal page, web page, or a document on your website. You can also link
to a web page version of an email message, or create links to desktop and mobile versions of your
content.
1. Select the Insert link button on the HTML editor.
2. The Insert Link screen appears.
3. From this screen, the user can add a link to another web page.
4. If the user has a personal page on your website, the user can also link to it.

Insert a link to a web page or document
To insert a link:
1. On the Edit Part screen, click the Insert link button.
2. The page link screen appears.
3. Select whether to create or remove a link from the part.
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4. To open the linked page or document in a separate window, enter a name for the window in the
Open in another window named field.

5. To display multiple linked pages or documents in the same separate window, enter the same
window name in the Open in another window named field for each link to open in the
window.

Note: To access the page link screen from the HTML editor, such as on the Helplets tab or in Email,
click Insert link on the toolbar.

Link to site page
To create a link to another page on your website:
1. Select Create link to Blackbaud NetCommunity Spark page.
2. Browse to the page to link.

l To link to a Blackbaud NetCommunity Spark page, you must have rights to view pages.
l For more information about view rights, see the Users & Security Guide.

Link to special page
To create a link to a page defined in Sites & settings, a web page version of an email message, or a
desktop or mobile version of your content:
1. Select Create link to special page.
2. In the Page field, select the option to link.
1. The home page, user login page, and privacy page you define in Sites & settings appear. For

more information, see the Administration Guide.
2. l In addition to the user login page you define in Sites & settings, additional user login

pages appear so you can select the password reset page on your website.
l When you include this page link in email messages and an email recipient clicks the link, a
secure page appears with a Forgotten Password field for the user to enter their email
address.

l This link remains active in the email for the user to take action to reset the password any
time.

l After the email address is submitted on the web page, another email sends to the user.
That email contains another link that returns the user to the reset password page on your
website.

3. When you use the HTML editor to design an email message, the View email message on web
page option appears.

l Select this to provide a way for email recipients to view your email design on a web page.
l You do not manually create the page the email message appears on and you cannot open
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it in Pages & templates. The program automatically renders your HTML email design to
display the message and you can only access it from the link in the message.

l To test the link, send a test message. The link does not work when you preview the
message.

4. When you design a layout, Menu part, or Formatted Text and Images part, the View desktop
version and View mobile version options appear.

l You can create links to one or both options to allow users to toggle between the desktop
and mobile versions of your content.

Link to mobile version of content
To include a link to the mobile version of your content, you must first create a mobile optimised
layout and style sheet.

Note: For more information, see the Website Design Guide.
To link to a specific location on the page:
1. Select Create link to an anchor in this document.
2. In the Anchor field, select the predefined anchor to link to.
3. For information about how to insert an anchor, see HTML Editor Functions on page 12.

Create other link
To create another type of link:
1. Select Create other type of link.
2. In the Type field, select the type of link to create.

l For example, select “ftp:,” “http:,” or “telnet.”
3. In the URL field, enter the exact path to the page to link.

Link to document on website
To create a link to a document on your website, such as an Adobe Acrobat portable document file
(*.pdf) or a MicrosoftWord document (*.doc):
1. Select Create link to Blackbaud NetCommunity Spark document.
2. Browse to the document to link.

ConstituentCodes
A constituent code tells you why a constituent is in your database. For example, you select a
constituent code from The Raiser's Edge, such as Friend, to associate with users who donate on your
website. You can select additional constituent codes from The Raiser's Edge to associate with other
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constituents, such as Event Participant or Volunteer. This way, when a user submits data on your website
for processing to The Raiser's Edge, you efficiently track the reason each constituent is in your
database.
In the program, there are two ways to download constituent codes.
• You can select constituent codes for new constituents in NetCommunity Options. After a
transaction is processed, these constituent codes automatically apply to new constituent records.

• When you create certain part types, you can select to associate a constituent code with the part.
When the website user submits data for the part, the constituent code defaults in the transaction.

Automatically Apply Constituent Codes
From Options on the NetCommunity page, when you select a constituent code for New Constituents,
the constituent code downloads automatically to The Raiser's Edge for all new constituent records
processed from the program. The code does not download to existing constituent records.

Tip: Selecting a constituent code for New Constituents is optional. In The Raiser's Edge, to query on
new records created from the program, we recommend you select a constituent code in New
Constituents.
If you select a constituent code for the Matching Gifts option, the constituent code downloads
automatically to The Raiser's Edge for all new organisation records processed from a matching gift
donation.

Constituent CodesOn a Transaction screen
From the NetCommunity page in The Raiser’s Edge, the Sign-Up Requests, Donations, Volunteer
Requests, and Event Registrations transaction types include a constituent code field. The constituent
code in the field defaults in both new and existing records in The Raiser’s Edge.
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The constituent code in this field defaults from the Constituent Code field on the Edit Part screen in
Parts. For example, Online is the constituent code for Donations transactions. When the Donation Form
part was created, Online was selected in the Constituent Code field.

l If the constituent code on the transaction screen is the same code as the New Constituents
constituent code, the code is not duplicated on the Bio 2 tab in the constituent record in The
Raiser’s Edge.

l If the constituent codes are different, both codes download to the new constituent record.
You can download the constituent code to an offline constituent record. You can also select a different
constituent code for the constituent. To prevent the constituent code from downloading to The
Raiser's Edge, delete the code from the field.

Constituent Codes and Part Types
Review the following information for details about the Constituent Code field on various part types in
the program.

User Login
The code applies to new and existing constituent records and is specific to each User Login part.

l For example, you can create separate login parts for subsites you create, such as multiple
chapters. The constituent code for a login part may be Atlanta Member.
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The constituent code you select for this part defaults to the Transaction Constituent Code frame in
Sign-up Requests on the NetCommunity page in The Raiser’s Edge for processing.
The code selected for New Constituents in Blackbaud NetCommunity SparkOptions also downloads
to The Raiser’s Edge for new constituents.

l However, if the constituent code on the User Login part and in New Constituents is the same,
the code is not duplicated on the record in The Raiser’s Edge.

Donation Form
The constituent code applies to new and existing constituents.
This is the same for the donation steps in a Personal Page Manager and a Fundraiser part.

Event Registration Form
The constituent code applies to new and existing event registrants.

Fundraiser
This part contains two Constituent Code fields:
1. The first field, located on the Step 2: Fundraiser Options screen, downloads automatically to new

and existing records in The Raiser's Edge.
l This constituent code is typically used if you consider the fundraiser participant
constituency to be different than a regular Blackbaud NetCommunity Spark user
constituency.

l These constituent codes do not appear in the Fundraiser transaction on the NetCommunity
page in The Raiser’s Edge. However, after you process the transaction, they appear
automatically on the Bio 2 tab in the constituent record.

2. The second Constituent Code field, located on the Step 6: User Login Form screen, applies to
users who register for the Fundraiser that are not yet members of your site.

l This constituent code defaults to the Transaction Constituent Code frame on the Sign-up
Requests transaction on the NetCommunity page in The Raiser’s Edge.

This is the same for the two Constituent Code fields in a Personal Page Manager part. The first field is
on the Step 1: Personal Page Options and Administrator Roles screen. The second field is on the Step
2: User Login Form screen for a Personal Page Manager. It applies to users who sign up using the
personal page registration.

Membership Form
• The constituent code applies automatically to new and existing constituent records. This includes
members or gift of membership recipients.
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• This constituent code does not appear in the Memberships transaction on the NetCommunity page
in The Raiser’s Edge.
l However, after you process the transaction, it appears on the Bio 2 tab in the constituent record.

Volunteer Opportunity
The constituent code downloads for volunteers who sign up for a job online. The code applies to
existing constituent records.
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